Chapter 6
The Design Worksheet-Part 4-Final Design Procedure

Introduction

This portion of the Design Worksheet starts the design procedure and verifies information already defined in the Manufacturer’s Worksheet. The owner should verify these items with the Manufacturer one last time before the Foundation Design Concept is investigated for structural verification. Example #1 will be continued here.

Final Design Procedure

A. The User selects the Design Worksheet-Part 4-Final Design Procedure from the pull-down Menu. The form window will appear on the screen.

- Question #42: The actual building width is the width of one of the units that makes up the Multi-Section unit. From the Manufacturer's Worksheet this value is already known to be 13'-8" and it has been automatically inserted in the blank box as illustrated in the portion of the completed illustration of the Form Window shown below:

<table>
<thead>
<tr>
<th>PART 4: FINAL DESIGN PROCEDURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Accompanies Chapter 6)</td>
</tr>
<tr>
<td>42. What is the actual building width?</td>
</tr>
<tr>
<td>(Mfg. Wkst. #4)</td>
</tr>
<tr>
<td>43. The nominal building width to be used in the Foundation Design Tables, (A/C. A &amp; A) is Wt</td>
</tr>
<tr>
<td>(011-2-A and Figure 6-1)</td>
</tr>
<tr>
<td>44. Where are the foundation supports located? Check drawings submitted by the owner and Foundation Design Concepts in Appendix A. Circle the support locations shown on the Manufacturer’s foundation concept plan.</td>
</tr>
<tr>
<td>45. Do these locations match the Foundation Concept shown in Appendix A? Do the locations match Question #41 on the Design Worksheet?</td>
</tr>
<tr>
<td>(If yes, proceed. If no, return to Owner for clarification.)</td>
</tr>
<tr>
<td>46. Is Vertical Anchorage present?</td>
</tr>
<tr>
<td>(001-2-B, 001-3-B &amp; 001-4-B (Figures 6-7 &amp; 6-8), Mfg. Wkst. #12 &amp; #16)</td>
</tr>
<tr>
<td>47. yes no</td>
</tr>
</tbody>
</table>
It is possible to change this dimension at this point in time. Either by selecting the far right button and revising the dimension in the Superstructure Dimensions dialog window or by use of the down-arrow.

**Note:** Changes in the Design Worksheet will not be automatically updated in the other two Worksheets. This is repeated here again for emphasis.

- **Question #43:** The nominal width is automatically inserted, based on the User’s answer to question #42 above.
- **Question #44:** The User should review the drawings prepared by the owner or the manufacturer, along with the Foundation Design Concepts of Appendix A, to verify the support locations for the transfer of gravity loads to the foundation. In this example, it was decided to use piers under the chassis beams and marriage wall, along with the continuous wall/footing of the exterior walls. Choose all three options on the Form.
- **Question #45:** This is a “yes/no” question to verify that the Foundation Concept shown in the Appendix A dialog window has “up” pointing arrows at all these locations on the Type E1 Support illustration. Since “up” pointing arrows do exist at all three locations of possible support, answer “yes”.
- **Question #46:** There are several green typed and underlined references that access the On-Line “Handbook” text and Multi-Section unit Foundation Concept illustrations. They can be used to verify the intended points where anchorage for overturning and uplift may occur. Note that for the Type E1 Concept there are two options. During the design process the User will try two points of Anchorage first, and if that doesn’t work four points will be tried. Looking at the illustration for Anchorage for the Type E1 Concept that “down” arrows exist at the exterior walls for one option and at the exterior walls plus two chassis beam lines. This was illustrated in Chapter 4 on page 5. Thus, Anchorage is available, so answer “yes”.
- **This completes Part 4 - Final Design Procedure.** See Appendix A for a printout.
Chapter 7
The Design Worksheet - Required Footing Size - Part 4

Introduction

This portion of the Design Worksheet begins the real structural design of the foundation. The first step is to make sure that the foundation is capable of transmitting all gravity dead and live loads to the footings without exceeding the net allowable bearing pressure provided in the Owner’s Site Acceptability Worksheet, questions #10 and #11.

Appendix A
A. The User selects the Design Worksheet-Part 4: Required Footing Size from the Worksheets pull-down Menu. The form window will appear on the screen as shown below. All of the blank boxes have been automatically filled in based on answers from the Manufacturer’s Worksheet. These are the preliminary values that will be investigated and revised as required to arrive at the most economical and desirable spacings.

• Question #47: The User can stay with the choice from the manufacturer or (1) use the down-arrow key to view the drop-down list box and revise the foundation concept choice, or (2) choose the far right button to return to the Foundation Design Concept dialog window for further review or to change the foundation concept type.
Assume the User chooses to stay with the Type E1 foundation concept.

- Question #48: It is visually best to begin by selecting the far right button to bring up the Foundation Dimensions dialog window as shown below. It will contain a foundation plan for the Type E1 Concept with the chassis beam line piers shown at the preliminary spacing selected, symmetrically placed from the ends of the unit. Dimensions are shown and will automatically change to reflect any revision to the pier spacing at the upper left part of the window. To become familiar with this graphical process, use the down-arrow and select 8 feet pier spacing from the drop-down list box and watch the foundation plan be automatically re-drawn. It should become apparent to the User that fewer piers are shown and that this could indicate less foundation construction cost. The 1000 psf net allowable soil bearing pressure selected earlier could be re-evaluated by a geotechnical engineer and a larger bearing value established. Return to the 5 foot spacing to continue this Example #1.
Note that at this point no marriage wall piers are shown. The User should select the “Marriage Wall Pier Spacing” button to bring up the **Marriage Wall Pier Spacing** dialog window as shown below:

Only the marriage wall is shown between the Unit’s end walls. The options for insertion of piers along the marriage wall are numerous. Assume that the living room is at the left end of the plan and a double width open space is desired. Type in “16 feet” as the **distance from the left end wall** and press the **Add Pier** button. Automatically a pier is located. To place a second opening along the marriage wall 12 feet to the right of the one currently shown, select **Add Pier**. A pier will appear with dimensions that dynamically change as the mouse is moved. Scroll the mouse until the 12 foot dimension appears and then click the left mouse key to fix its position. The partial illustration below is an action shot in progress of achieving the 12 feet dimension.
To remove the wall where the two openings exist, place the mouse pointer anywhere along the wall in the 16 foot length. Note in the illustration that follows that the pointer changes to a different shape arrow similar to that circled in the illustration. Click the left mouse key and the wall disappears. Repeat this process for the 12 foot space and that wall will also disappear. The remainder of the marriage wall is to remain continuous. To add uniformly spaced piers under the continuous part of the wall, select the down-arrow key and scroll down the drop-down box list to 8 feet. Select the Add Uniform button then click the left mouse key on the location to uniformly place the piers at 8'-0" on center in the plan, again symmetrically placed.

It is possible to move any individual pier by placing the mouse pointer on the pier. Note that a double arrow head will appear similar to that shown below within the dotted circle. Hold the mouse key down and scroll left or right to
move the pier. The dimensions will dynamically change until the User is satisfied.

Select OK when satisfied with the marriage wall layout and the User returns to the Foundation Dimensions dialog window; however, now the marriage wall openings and piers with their locations are shown as below:

**Note:** The upper right part of the window will be used in the next section of the Form.

The User chooses OK and returns to the Form window, having completed a first trial of the marriage wall pier layout and the chassis beam pier layout. The User now scrolls down the Form window to the Appendix B portion of the Design Worksheet as shown below:
## Appendix B

### Required Footing Size

<table>
<thead>
<tr>
<th>Question</th>
<th>Footing Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>49</td>
<td>E1</td>
</tr>
<tr>
<td>50</td>
<td>2.0 sq ft</td>
</tr>
<tr>
<td>51a</td>
<td>5.7 sq ft</td>
</tr>
<tr>
<td>51b</td>
<td>9.1 sq ft</td>
</tr>
</tbody>
</table>

- **Question #49 to #51b**: This portion of the Design Worksheet has its boxes already filled in with data and footing sizes. The **Foundation Concept Design** is still the Type **E1** that came from the **Manufacturer's Worksheet**. Always, the User is allowed to change that choice by the usual mouse maneuvers. All of the footing sizes are best determined from the **Gravity Load Footing Size** dialog window. Choose the **Gravity Load Footing Size Icon** from the **Main Tool Bar**, or choose the **Gravity Load Footing Size** command from the **Pull-down Menu Bar**, or choose the far right button of any of the questions in this group on the Form to access that window.
A dead and live load summary of previous choices is shown. Again, this is another chance to make any required changes. Selection of any of the buttons returns the User to the dialog windows previously viewed. The same option to revise the net allowable soil bearing pressure selected on the Owner’s Worksheet is given. The pier dead loads are default values prepared for the “Handbook”, yet even these can be changed by an experienced User. Select the button for the typical chassis beam line Pier. A Self Weight dialog window will appear with the default dead load value shown; however, entries can be made to revise that magnitude and the total will automatically sum the new weights. Select OK and return the new value to the Gravity Load Footing Size dialog window.
The preliminary selected spacings for all the different piers are shown. A variety of options can be attempted by the User with the buttons available on this dialog window. The User can increase the net allowable soil bearing pressure and watch the footing sizes decrease in area. The User can increase the spacing of the piers and watch the footing sizes increase due to the added load they will carry. The values shown in this dialog window will be returned to the Design Worksheet - Appendix B boxes after the User is satisfied and selects OK.

**Note:** The footing widths shown represent the width of a square footing, therefore the square root of the footing areas.

**Note:** The footing sizes will not exactly match those sizes shown in the “handbook” example #1, since the unit here was based on default values of dead load and thus a smaller (W) has been used.

**Note:** The User may select Graphics Window from the Window menu to return to the PFGMH Graphics Window to view the Foundation Concept E1 with the piers and their spacings in all four views, as shown below. The perspective can be manipulated as described in Chapter 2.
Note: Now that the marriage wall openings have been defined the program automatically updates the Design Worksheet total self weight (W) of the unit as shown below.

- 21. What is the building self weight (W)?  
  (Mfg. Wght #9)  
  **38,525** lbs.

- 22. What is the building length (L)?  
  (Mfg. Wght #3)  
  **56'-0"** ft.

- 23. What is the distributed weight per foot of unit length? (w=W/L)  
  (402-B, 6)  
  **688** lbs/ft.

- This completes the required footing sizes (Aftg) for Example #1. See Appendix A for a printout of this portion of the Design Worksheet.
Chapter 8
The Design Worksheet - Part 4
Av - Transverse Direction

Introduction

This portion of the Design Worksheet is intended to investigate the ability of the foundation Type selected to resist uplift and overturning. There is a need to provide vertical anchorage between the superstructure and the foundation to facilitate this resistance. The Type E1 Foundation has two anchorage options as shown in the partial enlargement of Figure 6-8 from the “Handbook”.

Chapter 4-The Manufacturer’s Worksheet discussed these options in detail. Now it will be necessary to determine the required anchorage force based on the wind loads determined in Chapter 5 - Site/Loads. In that Chapter it was found that seismic inertia forces need not be considered.

Vertical Anchorage Requirements in the Transverse Direction

A. Select the Design Worksheet - Part 4 - Av-Transverse Direction command from the Worksheets pull-down menu. The Form window will appear on the screen as shown below. Certain values have been entered in several of the boxes and others are blank.
### Vertical Anchorage Requirements in the Transverse Direction (602-4)


<table>
<thead>
<tr>
<th>Exterior Av</th>
<th>65</th>
<th>*</th>
</tr>
</thead>
<tbody>
<tr>
<td>(lbs./ft. for spacing, lbs./ft. for E type, lbs./ft. for down spacing)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

52b. Number of vertical tie-down locations for multi-section units

<table>
<thead>
<tr>
<th>Interior Av</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
</tr>
</tbody>
</table>

52c. For units with additional vertical anchorage at the interior piers, determine the Required Vertical Anchorage.

| Exterior Av | 200 |
|-------------|
| (lbs./ft. of pier spacing) |

54. Is this value (#53) greater than the value given in #52a? (If yes, continue. If no, return to owner for clarification.)

| Yes | No |

**Question #52a and #52b:** The number already inserted in the box comes from the **Overturning** dialog window, and this is the best place to start. Select the **Overturning Icon** from the main tool bar, or select **Overturning** from the Design pull-down menu or select the far right button at the end of question #52a to bring up the **Overturning** dialog window as shown below:

![Overturning Dialog Window](image)

The top left of the window provides a summary of the dead loads previously selected, which can still be altered by use of the buttons to access the **Dead Loads** dialog window.
The upper right side of the window is a summary of the wind loads as already calculated for the building geometry and site. The button allows the User to return to the Wind Load dialog window if any last minute changes are required. The left center of the window provides the seismic inertia forces at the roof and floor levels; however, seismic is not a consideration according to ASCE 7-93 for manufactured housing in Champaign, IL. The number of vertical tie-downs is indicated as 2, which is shown as option 1 above in the Introduction. This implies that the superstructure will be anchored at the exterior walls only. The required overturning force \((A_v)\) is indicated as 65 plf along the exterior walls. The calculations are not shown here, but can be found in Appendix D of the “Handbook” in section D-300.2.F and are illustrated in Figure D-14 for two and four tie-downs. To demonstrate the use of this dialog window, try option 2 by using the down-arrow to reveal the drop-down list box and highlight 4 vertical tie-downs. The following portion of the Overturning dialog window is shown below to reveal the new \((A_v)\) values at the exterior walls and at the interior piers under the chassis beams. Again the calculations are based on equations found in the “Handbook” reference cited above.

It is at this point that the User requires the assistance of the On-Line “Handbook”- Appendix C - Table C-1. Select The Guide from the Help pull-down menu bar to bring up the full Table of Contents for the “Handbook” as shown below.

**Note:** Chapters not typed in green and underlined cannot be accessed.
Select Appendix C - Foundation Capacity Tables, which is typed in green and underlined. This will bring up the Chapter Table of Contents as shown below:

Select Section C-200. Withdrawal Resistance Capacities Tables, to reveal the text of that section as follows:
Select the green typed and underlined Table C-1 to reveal the Longitudinal Foundation Walls Anchorage Table C-1 as follows:

<table>
<thead>
<tr>
<th>hw</th>
<th>Reinforced Concrete</th>
<th>Masonry-Grouted 6&quot; CMU</th>
<th>Masonry-Grouted @ 48&quot; o.c.</th>
<th>All-Weather Wood w/ Cone Footing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Footing Width</td>
<td>Footing Width</td>
<td>Footing Width</td>
<td>Footing Width</td>
</tr>
<tr>
<td>2'-0&quot;</td>
<td>12&quot;</td>
<td>16&quot;</td>
<td>12&quot;</td>
<td>16&quot;</td>
</tr>
<tr>
<td>2'-8&quot;</td>
<td>255</td>
<td>300</td>
<td>231</td>
<td>276</td>
</tr>
<tr>
<td>3'-4&quot;</td>
<td>325</td>
<td>363</td>
<td>295</td>
<td>351</td>
</tr>
<tr>
<td>4'-0&quot;</td>
<td>395</td>
<td>466</td>
<td>355</td>
<td>426</td>
</tr>
<tr>
<td>4'-8&quot;</td>
<td>465</td>
<td>550</td>
<td>417</td>
<td>502</td>
</tr>
<tr>
<td></td>
<td>535</td>
<td>633</td>
<td>479</td>
<td>577</td>
</tr>
</tbody>
</table>

Use the scroll bars to review the details, notes, and the Capacities Table. All the capacities shown in table C-1
exceed the required anchorage (Av) of 65 plf, which means that two tie-downs is more than ample and more economical than involving twice as many tie-down connections.

Example #1 will use 2 tie-downs. Switch back to the Form window. It now should be understood where the 65 plf and the 2 tie-downs answers came from.

- Question #52c: This box remains blank unless more than 2 tie-downs are used. If option 2 (4 tie-downs) were selected the 133 lbs. would have been inserted, as well as question #52a changed to 43 plf and question #52b changed to 4 tie-downs.
- Question #53 & #54: From the Manufacturer’s Worksheet the superstructure’s anchorage capacity of 200 plf has been automatically inserted in the Form. This is more than adequate to anchor with 65 plf. Thus, the answer to question #54 is “yes”, which is also automatically answered.
- This completes the Vertical Anchorage Requirements in the Transverse Direction, meaning the Overturning.
- See Appendix A for the Design Worksheet printout.
Chapter 9

The Design Worksheet-Part 4 - Ah - Transverse Direction

Introduction

This portion of the Design Worksheet is intended to investigate the ability of the Foundation Type E1 selected to resist sliding in the transverse direction. There is the need to provide anchorage between superstructure and foundation to facilitate this resistance. The Type E1 Foundation generally relies on shear walls for this purpose; however, shear walls in combination with vertical X-bracing planes is also possible. Example #1 is basically a shear wall example. The vertical X-bracing will be discussed in Example #2 in Chapter 16.

Horizontal Anchorage Requirements in the Transverse Direction

A. Select the Design Worksheet - Part 4 - Ah Transverse Direction from the Worksheets pull-down menu. The Form will appear on the screen as shown below. Certain values have been entered in several of the boxes and others are blank.
• Question #55a: The answer of “2” in the box comes from the **Foundation Dimensions** dialog window. This is a quantity of transverse resistance planes generally tried first. It implies that the two exterior transverse walls are the only two shear walls where anchorage will be made. Select the **Foundation Dimensions** dialog window by the usual options: the **icon**, the **Geometry & Loads** pull-down menu or by selecting the button at the far right of the question. A portion of that **Foundation Dimensions** dialog window is illustrated below as currently filled in.
Question #56: It is important to know the magnitude of the sliding force that is required to be resisted, before the decision can be made of how many transverse resistance planes are needed. To that end, choose the **Transverse Sliding Icon** from the **Main Tool Bar**, or choose **Transverse Sliding** from the **Design** pull-down menu, or choose the far right button at the end of question #56. The **Transverse Sliding** dialog window will appear as follows:
This dialog window repeats the information of the **Overturning** dialog window regarding dead, wind and seismic loads. It also repeats the section for the Number of Transverse Lateral Resistance Locations: 2. The “2” implies that only the exterior transverse walls will be used to resist sliding. The calculations are automatic, but the formulas can be referenced in the “Handbook” in **Appendix-D** in section D-300.4 and D-300.5. The required sliding force \((Ah) = 267\) plf is due to **Wind** along the two exterior shear walls. Note in question #57a that the Manufacturer has supplied a superstructure capable of resisting 400 plf. This number was automatically entered based on the **Manufacturer’s Worksheet** answers. It is at this point that the User requires the assistance of the On-Line “Handbook” - **Appendix C** - Table C-5A. Follow the procedure used in Chapter 8 to access that Table. All the capacities shown exceed the required sliding anchorage \((Ah)\) and it is clear that two connections are all that is required.

It is important to test the capability of the **Transverse Sliding** dialog window even though the answer desired has been determined. Just for fun, select the **Number of**
Transverse Lateral resistance Locations as 4 and notice the change in the (Ah) values shown below:

<table>
<thead>
<tr>
<th>Seismic Load Summary (lbs)</th>
<th>Number of Transverse Lateral Resistance Locations:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Wind</td>
</tr>
<tr>
<td>Roof:</td>
<td>Ah Required</td>
</tr>
<tr>
<td></td>
<td>Seismic</td>
</tr>
<tr>
<td></td>
<td>Wind</td>
</tr>
<tr>
<td></td>
<td>Seismic</td>
</tr>
<tr>
<td>Roof:</td>
<td>619</td>
</tr>
<tr>
<td>Floor:</td>
<td>122</td>
</tr>
<tr>
<td>Ah Required</td>
<td>Wind</td>
</tr>
<tr>
<td>End Wall:</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>0</td>
</tr>
<tr>
<td>Interior Wall:</td>
<td>138</td>
</tr>
<tr>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

It is clear that the interior shear walls will pick up twice as much of the sliding force, yet both values are well below the 267 plf for two shear walls. Plus, the automatic change to the foundation plan in the Foundation Dimensions dialog window looks as follows:

- Return to using 2 shear walls and scroll down the Form window to reveal more of the questions:
Since the 400 plf is greater than the actual sliding force of 267 plf, the answer to question #58a is “yes”, which has already automatically been black bordered. The blank boxes of all the other questions refer to vertical X-bracing planes, which are not used in this Example #1, but will be used in Example #2.

- This completes the **Horizontal Anchorage Requirements** for **Transverse Sliding**. See Appendix A for a printout of this portion of the Design Worksheet.
Chapter 10
The Design Worksheet-Part 4
Ah - Longitudinal Direction

Introduction

This portion of the Design Worksheet is intended to investigate the ability of the Foundation Type E1 selected to resist sliding in the longitudinal direction. There is the need to provide anchorage between superstructure and foundation to facilitate this resistance. The Type E1 Foundation generally relies on the long shear walls for this purpose. Example #1 is basically a shear wall example. The vertical X-bracing solution will be discussed in Example #2 in a later Chapter.

Horizontal Anchorage Requirements in the Longitudinal Direction

A. Select the Design Worksheet - Part 4 - Ah Longitudinal Direction from the Worksheets pull-down menu. The Form will appear on the screen as shown below. Certain values have been entered in several of the boxes and others are blank.

---

62a. Using the tables, find the required horizontal anchorage (Ah) in the longitudinal direction. (Appendix B, Part 4) (602-4.3)

62b. Using vertical X-bracing planes and the formulas in section 602-4.2 (d) determine anchorage value for X-bracing planes. (602-4.3) Using exterior long walls, step to item 603.

1. Number of choice beam lines used for vertical X-bracing planes.

2. Horizontal anchorage (s) required force, based on formula.

3. Assumed height (b-h) based on Figure 6-11.

4. Tension (fT) based on formula. (602-4.2.3)

63. What is the manufacturer-supplied value for horizontal anchorage? (602-4.6.1.3)
• Question #62a: The answer of 48 plf is already entered. It has come from the Longitudinal Sliding dialog window and that should be reviewed first. To that end, choose the Longitudinal Sliding command from the Design pull-down menu, or choose the far right button at the end of question #62a. The Longitudinal Sliding dialog window will appear as follows:

This dialog window repeats the dead load summary found in many of the dialog windows, but this time the Wind Load summary is for the longitudinal direction, as is the Seismic Load summary.

**Note:** The transverse and longitudinal seismic inertia forces are the same, since the mass is the same in both directions and the other seismic factors remain the same as well.

The required longitudinal sliding force \((Ah) = 48\) plf for wind, and although not needed in this case, \((Ah) = 10\) plf for seismic resistance. Clearly, wind controls here anyway. The 48 plf was automatically entered in question #62a of the Form shown above. It should be pointed out that the \((Ah)\) value applies along both exterior long walls. The calculations
are not shown here, but can be referenced in the “Handbook” in Appendix D - section D-300.6 and illustrated in Figures D-24 and D-25.

It is typical for the Type E1 Concept that the long exterior walls provide all the longitudinal sliding resistance. It is important to know the magnitude of the longitudinal sliding force (Ah) that is required to be resisted, and to know that anchorage between superstructure and foundation can be made that provide that capacity. Further, the User should reference Appendix C of the On-Line “Handbook”, in particular Table C-5A by the procedure described in Chapter 8. The partial Table is shown below. Note that all the capacities are 300 plf or greater. Thus, anchorage for sliding will not be critical.

Concrete or Masonry

<table>
<thead>
<tr>
<th>Capacity (2)</th>
<th>Required Anchorage (5)</th>
</tr>
</thead>
<tbody>
<tr>
<td>lbs/ft</td>
<td>Anchor Bolt (4)</td>
</tr>
<tr>
<td>300</td>
<td>1/2&quot;</td>
</tr>
<tr>
<td>600</td>
<td>1/2&quot;</td>
</tr>
<tr>
<td>675</td>
<td>1/2&quot;</td>
</tr>
<tr>
<td>900</td>
<td>1/2&quot;</td>
</tr>
<tr>
<td>1350</td>
<td>1/2&quot;</td>
</tr>
<tr>
<td>1800</td>
<td>1/2&quot;</td>
</tr>
</tbody>
</table>

*** For required Ah greater than 1800 lbs/ft, consider using an engineered design with a higher capacity.

• Question #63: The manufacturer has supplied the longitudinal sliding capacity of the superstructure in the Manufacturer’s Worksheet as 400 plf. This was automatically inserted in the Form here. Obviously, there is plenty of capacity in that regard.

• Question #62b, #64b through #66: These questions apply to the use of vertical X-bracing planes to provide sliding resistance, which is appropriate for other foundation concepts, and the boxes will be left blank here. Another Chapter will address their use in Example 2.

• This completes Horizontal Anchorage in the Longitudinal Direction for Example #1. See Appendix A for a printout of this portion of the Design Worksheet.
Introduction

This portion of the Design Worksheet is intended to verify that sufficient depth so that Withdrawal Resistance is provided for Transverse Overturning due to wind (in this Example #1), and still provide sufficient depth for Frost Protection.

Withdrawal Resistance Verification

A. Select the Design Worksheet - Part 4 - Withdrawal Resistance from the Worksheets pull-down menu. The first portion of the form will appear on the screen as shown below. All the answers are already shown; however, this portion of the Form would initially contain mostly blank boxes.

- Question #67: The Maximum Frost Penetration Depth for Champaign, IL was determined from the Appendix H map H-4 as 30 inches. This value has been automatically entered here, and is the only value the User will see in this portion of the Form window.
The User should choose the green typed and underlined Table C-1 and use the scroll bar to view the table of values for the Masonry -Fully Grouted exterior walls as shown below. The User can reference Chapter 8 and the Design Worksheet question #52a, where the Required (Av) = 65 plf to resist overturning uplift was determined, or select Overturning from the Design pull-down menu to verify the value. It is clear that 6” CMU units grouted at 48” on center with 195 plf would be the least value greater than the required 65 plf. However, the fully grouted walls was an owner’s choice, and the withdrawal capacity is slightly higher at 231 plf. The required height of wall (hw) = 2’-0” is the same for either choice. Enter the 2’-0” value in the box adjacent to the drawing. This single entry precipitates numerous entries into the empty boxes further down on the Form.
Table C-1

<table>
<thead>
<tr>
<th>hw</th>
<th>Reinforced Concrete</th>
<th>Masonry Fully Grouted 6&quot; CMU</th>
<th>Masonry Fully Grouted @ 4&quot; o.c.</th>
<th>All Weather Wood on Concrete or Gravel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Footing Width</td>
<td></td>
<td>Footing Width</td>
<td>Footing Width</td>
</tr>
<tr>
<td>12&quot;</td>
<td>12&quot;</td>
<td>12&quot;</td>
<td>12&quot;</td>
<td>12&quot;</td>
</tr>
<tr>
<td>16&quot;</td>
<td>16&quot;</td>
<td>16&quot;</td>
<td>16&quot;</td>
<td>16&quot;</td>
</tr>
<tr>
<td>2&quot;-0&quot;</td>
<td>255</td>
<td>300</td>
<td>231</td>
<td>276</td>
</tr>
<tr>
<td>2&quot;-8&quot;</td>
<td>325</td>
<td>383</td>
<td>293</td>
<td>351</td>
</tr>
<tr>
<td>3&quot;-4&quot;</td>
<td>395</td>
<td>466</td>
<td>355</td>
<td>426</td>
</tr>
<tr>
<td>4&quot;-0&quot;</td>
<td>465</td>
<td>550</td>
<td>417</td>
<td>502</td>
</tr>
<tr>
<td>4&quot;-8&quot;</td>
<td>535</td>
<td>633</td>
<td>479</td>
<td>577</td>
</tr>
</tbody>
</table>

- Question #67a: Select Masonry Fully-Grouted with the mouse pointer and a black border will indicate the choice.
- Question #67a.1: The withdrawal capacity of 231 plf is automatically entered in the box.
- Question #67a.2, 3, 4, 5, 6, 7, 8: These question are automatically filled in based on the (hw) value entered above. This is illustrated below:
The Design Worksheet - Part 4 - Withdrawal Resistance

Chapter 11

3) What is the height of the wall + footing for frost protection? (footing depth \(#9\) + \#7)

4) What is the greatest height \#67a.2 or \#67a.3?

Circle the height which controls.

5) Record the bottom of footing depth from grade. (Item \#67a.4 - \#7)

6) Using Table C-1, what is the required width of the wall footing for withdrawal?

7) Is item \#67a.6 greater than or equal to item \#49?

If yes, continue. If no, change footing width to item \#49

8) Record design exterior wall footing width.

---

**Question \#67b.1-6, \#67c:** The piers under the chassis beams and under the marriage wall in Example \#1 are only used for Support, they are not used for anchorage due to overturning or uplift. Also, since they are contained within the boundary of the exterior perimeter wall foundation, frost action can be ignored. The only real requirement for the placement of footings below grade would be the 18 inches of topsoil present at the site. The footings must rest on undisturbed soil. Thus, the pier and marriage wall footings must extend a minimum of 18 inches below grade or until undisturbed soil is reached. The boxes shown below can remain blank.

---

**b. Withdrawal Resistance for Piers:** (Types C, C1)
(concrete dead-man), I or type B with interior pier anchorage - multi-section units.

Circle pier type:

1) Using Table C-2, which capacity is greater than required \(\text{As}\)? \(\text{#52a and #52c (605-2 B (2))}\)

2) Using Table C-2, what is the height of the pier + footing for required withdrawal resistance? \((\text{hp} + \#7)\)
3) What is the required height of pier + footing for frost protection? (Frost depth (#9) + 12")

4) What is the greatest height #67b.2 or #67b.3?

Circle the height which controls

Withdrawal Withdrawal
Frost Depth Frost Depth

5) Record the bottom of footing depth from grade.

Item #67b.4 - 12"

6) Using Table C.2, what is the required width of the square footing if withdrawal resistance controls or if frost depth controls?

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]

\[ \text{in} \]
Chapter 12

The Design Worksheet - Part 4 - Vertical Anchorage & Reinforcement - Longitudinal Walls & Piers

Introduction

This portion of the Design Worksheet is intended to establish the connection components, sizes, spacings, and quantities, to complete the anchorage between superstructure and foundation for longitudinal walls and piers under chassis beams and marriage walls. It primarily uses Appendix C - Foundation Capacity Tables from the On-Line “handbook”.

Vertical Anchorage and Reinforcement for Longitudinal Walls and Piers

A. Select the Design Worksheet - Part 4 - Vert. Anchorage & Rein. For Long. Walls & Piers from the Worksheets pull-down menu. The Form will begin as shown below. Most of the values will already be entered in the boxes based on the data accumulated in the Design Worksheet and dialog windows to this point.
Question #68a.1 and 2: The required vertical anchorage capacity along the longitudinal exterior walls was found to be \( (A_v) = 65 \text{ plf} \) as determined on the Overturning dialog window and recorded on the Form for question #52a. Select the green typed and underlined Table C-4A to bring up the On-Line "Handbook" - Appendix C - Table C-4A, a portion of which looks as follows:
Table C-4A

<table>
<thead>
<tr>
<th>Vertical Capacity (5)</th>
<th>Required Anchorage (2, 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>lbs/ft</td>
<td>Anchor Bolt</td>
</tr>
<tr>
<td>Standard Washer</td>
<td>Over-Sized Washer</td>
</tr>
<tr>
<td>146</td>
<td>239</td>
</tr>
<tr>
<td>164</td>
<td>270</td>
</tr>
<tr>
<td>187</td>
<td>307</td>
</tr>
<tr>
<td>218</td>
<td>359</td>
</tr>
<tr>
<td>262</td>
<td>431</td>
</tr>
<tr>
<td>327</td>
<td>538</td>
</tr>
</tbody>
</table>

The smallest value, which exceeds the 46 plf, is the 146 plf using a standard washer, 1/2 inch diameter anchor bolts, #4 re-bar, and a 6’-0” maximum spacing. This value is highlighted in the illustration above for the User to spot it easily. All the above information is automatically entered in the Form boxes.

Scroll down the Form to view the next section of questions and inserted information:
Question #68.2.c: Select the green typed and underlined Table C-3A from the Form and access the On-Line “Handbook” - Appendix C - Table C-3A. A portion of Table C-3 and C-3A are shown below with boxes around values for discussion.

### Table C-3

**Vertical Anchor Capacity For Piers (1, 2)**

<table>
<thead>
<tr>
<th>Bolt Dia</th>
<th>Capacity Per Number Of Bolts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/2&quot;</td>
<td>4240</td>
</tr>
<tr>
<td>5/8&quot;</td>
<td>6620</td>
</tr>
</tbody>
</table>

[Diagram showing anchor details]
The pull-out capacity of a 1/2 inch diameter anchor bolt is 4240 lbs. The actual force at a 6'-0" spacing is 46 plf \times 6 = 276 lbs., which is much lower than the real capacity. Thus, 1/2 inch diameter anchor bolts set in grouted cores of the CMU units will be quite adequate. From Table C-3A the 1/2 inch diameter bolt requires a 16 inch lap with a #4 reinforcing bar hooked 6 inches. These connection sizes are all entered on the Form as shown above.

- Question #68a.3 & 4: All the boxes are left blank since this is not a permanent wood foundation wall.
- Question #68b: The Piers under the chassis beams and marriage wall are not required for anchorage due to overturning or uplift, therefore no reinforcement requirements are needed. It should be pointed out that if this were a high seismic zone, reinforcement would be required.

This completes the anchorage details of the longitudinal walls, which is all that is required for a Type E1 Foundation Concept with two tie-downs.
Chapter 13

The Design Worksheet - Part 4 - Horizontal Anchorage & Reinforcement - Transverse Walls

Introduction

This portion of the Design Worksheet is intended to establish the connection components, sizes, spacings, and quantities, to complete the anchorage between superstructure and foundation for transverse walls. It primarily uses Appendix C - Foundation Capacity Tables from the On-Line “handbook”.

Horizontal Anchorage and Reinforcement for Transverse Walls

A. Select the Design Worksheet - Part 4 - Horiz. Anchorage & Rein. For Transverse Walls from the Worksheets pull-down menu. The Form will begin as shown below. Most of the values will already be entered in the boxes based on the data accumulated in the Design Worksheet and dialog windows to this point.

---

### Horizontal Anchorage and Reinforcement for Transverse Foundation Walls (603-3)

69. Using Appendix C, Table C-5A or C-5B, verify that the foundation anchorage will resist sliding at the transverse end foundation walls. Use for types C, E, or I.

a. For continuous foundations.

Using Table C-5A (concrete & masonry) or C-5B (wood), which capacity is greater than the required (Ab) (603-3) (Item #36)?

<table>
<thead>
<tr>
<th>End Wall</th>
<th>Interior Wall</th>
</tr>
</thead>
<tbody>
<tr>
<td>300</td>
<td>lbs./ft</td>
</tr>
</tbody>
</table>

i) Using Table C-5A, find:

a) Required anchor bolt diameter

<table>
<thead>
<tr>
<th>1/2&quot;</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>in.</td>
<td></td>
</tr>
</tbody>
</table>

b) Required anchor bolt spacing

<table>
<thead>
<tr>
<th>72&quot; o.c.</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>in.</td>
<td></td>
</tr>
</tbody>
</table>
Question #69a: The required horizontal anchorage capacity to resist sliding in the transverse direction was determined from the Transverse Sliding dialog window and inserted in the box for Question #56 on the Design Worksheet as \((Ah) = 267 \text{ plf}\). Select the green typed and underlined Table C-5A to bring up the On-Line “Handbook” - Appendix C - Table C-5A, a portion of which is shown below:

The smallest value that exceeds the 267 plf is the 300 plf, which has been boxed for the User to spot easily. This value has been automatically entered in the Form. Thus, 1/2 inch anchor bolts, #4 re-bar, and a spacing of 72 inches on center maximum will satisfy the design requirement. These values have also been automatically entered on the Form.
Chapter 13  The Design Worksheet - Part 4 - Horiz. Anchorage & Rein. - Transverse Walls 89

Table C-3A

<table>
<thead>
<tr>
<th>Anchor Bolt Dia</th>
<th>Vertical Rebar</th>
<th>Minimum Lap Splice</th>
<th>Rebar Hook</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/2&quot;</td>
<td># 4</td>
<td>16&quot;</td>
<td>6&quot;</td>
</tr>
<tr>
<td>5/8&quot;</td>
<td># 5</td>
<td>20&quot;</td>
<td>7&quot;</td>
</tr>
</tbody>
</table>

1. The vertical anchor capacity is based upon the working capacity of ASTM A-36 rod stock anchor bolts in 2,500 psi concrete or grout. To fully develop this capacity, anchor bolts must be properly tamped with the pier’s vertical reinforcement.

2. The capacity is based on $f_c = 2,500$ psi; $F_y = 36,000$ psi.

- **Question #69c:** Select the green typed and underlined Table C-3A from the Form and access the On-Line “Handbook” - Appendix C - Table C-3A as done before in Chapter 12. For sliding anchorage the same values are used as for pull-out on anchor bolts.

<table>
<thead>
<tr>
<th>c) Using Table C-3A:</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Rebar size</td>
</tr>
<tr>
<td>(2) Lap splice</td>
</tr>
<tr>
<td>(3) Rebar hook length</td>
</tr>
</tbody>
</table>

- **Question #69a.2:** All the boxes are left blank since this is not a permanent wood foundation wall.

Continue to scroll down the Form:

- **Question #69b.:** The transverse exterior shear walls are not completed with diagonal braces as shown in a portion of Figure 6-10 From the On-Line “Handbook” below. Thus, all the questions in this section of the Form remain blank.
Continue to scroll down the Form:

- Question #69c.: Transverse exterior shear walls are used for sliding, not vertical X-bracing as shown in a portion of Figure 6-10 From the On-Line “Handbook” below. Thus, all the questions in this section of the Form remain blank.

This completes the anchorage detailing of the exterior shear walls due to sliding in the transverse direction for the Type E1 Foundation Concept. See Appendix A for a complete output of the Design Worksheet.
Introduction

This portion of the Design Worksheet is intended to establish the connection components, sizes, spacings, and quantities, to complete the anchorage between superstructure and foundation for longitudinal walls subjected to sliding in the longitudinal direction. It primarily uses Appendix C - Foundation Capacity Tables from the On-Line “handbook”.

Horizontal Anchorage for Longitudinal Foundation Walls

A. Select the Design Worksheet - Part 4 - Horiz. Anchorage - Longitudinal Walls from the Worksheets pull-down menu. The Form will begin as shown below. Most of the values will already be entered in the boxes based on the data accumulated in the Design Worksheet and dialog windows to this point.

<table>
<thead>
<tr>
<th>Horizontal Anchorage for Longitudinal Foundation Walls (003-3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>70. Using Appendix C, Table C-5A, or C-5B, verify that the foundation horizontal anchorage will resist sliding at the long foundation walls. Use for types C, E and I.</td>
</tr>
<tr>
<td>a. For continuous exterior foundation walls.</td>
</tr>
<tr>
<td>Using Table C-5A (concrete and masonry) or Table C-5B (wood), which capacity is greater than the required exterior AN (in Table 6-5) (item #52a)</td>
</tr>
<tr>
<td>300</td>
</tr>
<tr>
<td>1/2&quot;</td>
</tr>
<tr>
<td>72&quot; o.c.</td>
</tr>
<tr>
<td>1) Using Table C-5A, find:</td>
</tr>
<tr>
<td>a) Required anchor bolt diameter</td>
</tr>
<tr>
<td>1/2&quot;</td>
</tr>
<tr>
<td>b) Required anchor bolt spacing</td>
</tr>
<tr>
<td>72&quot; o.c.</td>
</tr>
<tr>
<td>c) Using Table C-3a:</td>
</tr>
<tr>
<td>(1) Rebar size</td>
</tr>
<tr>
<td>#4</td>
</tr>
<tr>
<td>(2) Lap splice</td>
</tr>
<tr>
<td>16&quot;</td>
</tr>
</tbody>
</table>
• Question #70a.: For Continuous Exterior Foundation Walls, as exist with a Type E1 Foundation Design Concept, the long walls resist the longitudinal sliding. The Required \((Ah) = 48 \text{ plf}\) was calculated in the Longitudinal Sliding dialog window and automatically entered in the box of question #62a on the Design Worksheet. Select the green typed and underlined Table C-5A to bring up the On-Line “Handbook” - Appendix C - Table C-5A as in Chapter 13. Again, the smallest value that is greater than the required \((Ah)\) is 300 plf. This value has been automatically entered on the Form. Thus, 1/2 inch anchor bolts, #4 re-bar, and a spacing of 72 inches on center maximum will satisfy the design requirement. These values have again been automatically entered on the Form.

• Question #70a.1.c: Select the green typed and underlined Table C-3A from the Form and access the On-Line “Handbook” - Appendix C - Table C-3A as done before in Chapter 13. For sliding anchorage the same values are used as for pull-out on anchor bolts.

Scroll down the Form to reveal more questions:

<table>
<thead>
<tr>
<th>(3) Rebar hook length</th>
<th>6&quot;</th>
<th>in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2) Using Table C-5B, find:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a) Required nailing</td>
<td></td>
<td>*</td>
</tr>
<tr>
<td>b) Minimum plywood thickness</td>
<td></td>
<td>in.</td>
</tr>
<tr>
<td>c) Required anchor bolt diameter</td>
<td></td>
<td>in.</td>
</tr>
<tr>
<td>d) Required anchor bolt spacing</td>
<td></td>
<td>in.</td>
</tr>
</tbody>
</table>

b. **For vertical X-bracing planes.**

(602-6.A.2)

Using Appendix C, Table C-5A, verify the diagonal anchorage to the pier footings and the tension capacity of the diagonals

1) Record the required horizontal force (E) from step #62b.2.

2) Table C-5A capacity for one 1/2" diameter bolt at 12" o.c.

|   | 1,800 | lbs |

• Question #70a.2: All the boxes are left blank since this is not a permanent wood foundation wall.

Continue to scroll down the Form:
• Question #70b.: Longitudinal exterior shear walls are used for sliding in Example #1, not vertical X-bracing. Thus, all the question in this section of the Form remain blank.

• This completes the anchorage detailing of the exterior shear walls due to sliding in the transverse direction for the Type E1 Foundation Concept.
• See Appendix A for a printout of the total Design Worksheet.
Introduction

This portion of the Design Worksheet capsule summarizes all the foundation requirements: the footing sizes, the pier and wall sizes, and the reinforcement requirements to resist overturning in the transverse direction, and the reinforcement requirements to resist sliding in both the transverse and longitudinal directions.

Summary Sheet

A. Select the Design Worksheet Summary Sheet from the Worksheets pull-down menu. The Form will begin as shown below. Most of the values will already be entered in the boxes based on the data accumulated in the Design Worksheet and dialog windows to this point.

<table>
<thead>
<tr>
<th>SUMMARY SHEET</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Accompanies Chapter 7)</td>
</tr>
</tbody>
</table>

### 71. Compare values from preceding questions.
Select the largest value.

#### a. Bearing area and vertical anchorage

1. Pier footings: types C, F & I.

<table>
<thead>
<tr>
<th>Piers</th>
<th>Exterior</th>
<th>Interior</th>
<th>Marriage Wall</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2.0</td>
<td>5.7</td>
<td>9.1</td>
</tr>
</tbody>
</table>

Required Effective Footing Area from questions #49, #50, & #51

Required footing area to resist withdrawal due to uplift from Question #67. (For single-section or 2 tie-down system, only the exterior piers resist uplift, for 4 tie-down only the interior piers and exterior walls resist uplift)

Bearing Area and Vertical Anchorage for Piers
Question #71a.1: The pier footing sizes under the chassis beams, the continuous marriage wall, and at the ends of marriage wall openings where posts exist in the wall are automatically inserted in the blank boxes. Since none of the piers participate in anchorage for overturning or uplift, the last two boxes remain blank.

**Note:** The largest reaction, from any of the three posts that define the two openings, was used to size the footing. Thus, conservatively all three footings will have the same footing size. This is also done for construction simplicity.

Scroll down the Form to reveal more of the Summary:

![Form](image)

The pier footing sizes are shown here as the larger of the footing areas required to not exceed the allowable soil bearing pressure or, the areas required to resist withdrawal. Since withdrawal was not considered for the piers in Example #1, no footing areas were entered in the boxes above. Thus, the bearing area sizes remain the largest sizes.
There is no required reinforcement for the piers, since they do not participate in vertical anchorage and the site is not in a high seismic zone. The boxes all remain blank.

The depth of pier footings under the marriage wall openings are recommended to be set at the depth required for the perimeter wall footings, which was 30 inches. This is strictly engineering judgement.

Blanks appear in the boxes for exterior and interior pier footings under the chassis beams because normally pier footings within the perimeter of exterior block wall footings are protected from the frost condition. They are generally set at the level of undisturbed soil, which in this Example #1 was 18 inches below the topsoil. The same option could be chosen for the marriage wall opening pier footings as well.

The User can print these values in the blanks by hand after the Form is printed.

Scroll down the Form to reveal more data as follows:

**Long Foundation Wall & Footing: Type E - Gravity Load Bearing and Withdrawal due to Overturning**

<table>
<thead>
<tr>
<th>2. Long Foundation wall footing: type E or I:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required Effective Footing Width.</td>
</tr>
<tr>
<td>Required Footing Width for soil bearing (#45)</td>
</tr>
<tr>
<td>Required Footing Width to resist split withdrawal</td>
</tr>
<tr>
<td>Wall Footing Size (largest of above)</td>
</tr>
<tr>
<td>Footing Depth, Grade to bottom of footing (#67a.5)</td>
</tr>
</tbody>
</table>

**From 68a.2 masonry and concrete:**

| Required anchor bolt diameter | 1/2" in |
| Required washer size | Standard |
| Required anchor bolt spacing | 6'-0" in |
| Rebar size | #4 |
Question #71a.2: The continuous exterior long foundation wall footing width is required to resist all gravity loads without exceeding the net allowable soil bearing pressure. The footing width is 1.0 feet (which is also the minimum width in this case). Also, for the Type E1 Foundation Concept with two tie-downs, withdrawal needs to be considered. For anchorage it was found that a footing width of 12 inches is adequate if set 30 inches below grade. This information is automatically entered in the blank boxes as shown above. The anchorage requirements were also set in question #68a.2 and are repeated here above and below.

Scroll down the Form to reveal more of the following:

- There is no permanent wood foundation so the next block of information is left blank.

Continue to scroll down the Form:

**Horizontal Anchorage in the Transverse Direction - Continuous Foundation Walls - Sliding**

<table>
<thead>
<tr>
<th>Lap splice</th>
<th>16&quot;</th>
<th>in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebar hook length</td>
<td>6&quot;</td>
<td>in</td>
</tr>
</tbody>
</table>

From 68a.4: Record answers from item #68a.4 and record sizes and spacings.

Required nailing

Minimum plywood thickness

Required anchor bolt diameter

Required anchor bolt spacing

<table>
<thead>
<tr>
<th>End Wall</th>
<th>Interior Wall</th>
<th>in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anchor bolt diameter</td>
<td>1/2&quot;</td>
<td></td>
</tr>
<tr>
<td>Anchor bolt spacing</td>
<td>2&quot; d.e.</td>
<td></td>
</tr>
<tr>
<td>Rebar size</td>
<td>84</td>
<td></td>
</tr>
<tr>
<td>Lap splice</td>
<td>16&quot;</td>
<td></td>
</tr>
<tr>
<td>Rebar hook length</td>
<td>6&quot;</td>
<td></td>
</tr>
</tbody>
</table>
• Question #71b.1: The two exterior transverse walls were used to resist sliding. Anchorage requirements determined in question #69a.1 are repeated here in the blank boxes for the end walls. If more than two shear walls were used, interior anchorage values would be automatically filled in also.

• Question #71b.2: The two exterior transverse shear walls were not intended to be completed with diagonal bracing. All the boxes are left blank.

• Question #71b.3: The two exterior transverse shear walls were not intended to be completed with Vertical X-bracing planes. All the boxes are left blank.

Continue to scroll down the Form to reveal the next section:

**Horizontal Anchorage in the Longitudinal Direction**
*Exterior Continuous Foundation Walls - Sliding*

c. Horizontal anchorage in the longitudinal direction - exterior foundation walls

1. Continuous foundation walls

   Reinforcing for longitudinal foundation walls; record only if larger sizes or closer spacing than recorded for vertical anchorage (#71a.2).

   *From #70a.1, concrete/masonry*

   - Anchor bolt diameter: 1/2" in.
   - Anchor bolt spacing: 72" o.c. in.
   - Rebar size: #4
   - Lap splice: 16" in.
   - Rebar hook length: 6" in.

   *From #70a.2, wood; record only if larger sizes or closer spacings than recorded for vertical anchorage (#71a.2)*

   - Required nailing: 

• Question #71c.1: The answers determined in question #70a.1 are automatically inserted in the proper boxes.

There is no Permanent Wood Foundation so the remaining boxes in this section are left blank.

Continue to scroll down the Form to the end:
2. Vertical X-bracing planes under chassis beam lines
   (#701s)

| Number of X-brace locations along one chassis beam line |  
| Spacing of X-brace locations along one chassis beam line |  
| Required anchor bolt diameter | in. |
| Number of bolts at top of footing at connection to the diagonal |  
| Diagonal strap size |  
| Connection to bottom flange of chassis beam (describe) |

72. Do foundation dimensions and details comply with Foundation Capacities Table, based on Foundation Design Table Values?

73. If #72 yes, approve. If no, return to applicant.

- **Question #71c.2:** There were no vertical X-bracing planes used for longitudinal sliding in this Example #1. Thus, the boxes remain blank.
- **Question #72:** The Hud Official reviewing these Worksheets can now substantiate that the Foundation design and its anchorage constitute a **Permanent Foundation** according to the requirements of the “Handbook”. The answer is “yes” in this case.
- **Question #73:** The answer is consistent with that of question #72, and the Hud Official selects “Approve”.

This completes the **Design Worksheet**. Select Print to receive a hard copy output. A sample output is found in Appendix A.